
LaDOTD CAD Standards Help 
Help Sources 
The CADconform menu, which is located on the MicroStation Main menu, contains links to a number 
of help sources, including the DOTD Electronic Standards for Plans web page, LaDOTD CAD 
Standards Help (this file), CADconform Help, CADconform Reference Guide and Altiva web support. 
If CADconform Help does not display, execute HTMLhelp.bat in the \Z_CADconform\docs folder. 

For up-to-date DOTD software and deliverable standards, visit DOTD Electronic Standards for Plans: 
http://www.dotd.louisiana.gov/highways/project_devel/design/electronic_standards_disclaimer.asp.   

Email Hollis Ward at hollisward@dotd.la.gov for additional help regarding DOTD CAD standards.  

MicroStation Resources Installation 
The DOTD “MicroStation Resources” download is installed using the Altiva DeployCAD installer.  
DOTD resource files are installed in the \LaDOTD_CAD_Standards folder, which is normally installed 
to the C:\Program Files\Bentley\Workspace\Projects software folder or a standard network 
\Workspace\Projects resources folder.  Be sure to read the Installation Notes in the License Agreement. 

The “MicroStation Resources” download is located at www.altivasoft.com/ladotd/.  A link to this site 
is provided on the DOTD Electronic Standards for Plans web page (see Help Sources). 

Installing and Managing Workspace Projects 
For a list of workspace projects, see the “Selecting Workspace Projects” topic below.  DOTD 
Workspace Projects are selected when running the DeployCAD installer and are defined by project 
configuration files (.pcf), which are copied to the \Workspace\Projects folder during workspace 
installation.  Project configuration files define any folder paths and MicroStation settings that are 
unique to a specific workspace project (e.g., Road-Site).  All PCF files in this folder are represented as 
Projects in the Workspace area of MicroStation Manager when MicroStation starts.  

The Project selection list in MicroStation Manager can be minimized by installing only Workspace 
Projects that are needed to create drawings or display/print files.  Projects that are not installed initially 
can be added later as needed by running the DeployCAD installer or by simply copying the project 
PCF file from the \LaDOTD_CAD_Standards\config\PCF folder to the \Workspace\Projects folder.  
On the other hand, Projects that are not being used can be removed by deleting the PCF file from the 
\Workspace\Projects folder. 

Selecting Workspace Projects 
The appropriate Workspace Project must be selected in the Workspace area of MicroStation Manager, 
which opens when MicroStation starts.  LaDOTD Workspace Projects, if installed, are as follows. 

LADOTD_Road-Site: Road, Landscape and other site work 

LADOTD_Bridge-Facilities: Bridge, Structural, Mechanical, Electrical, Architectural and Traffic 

LADOTD_Survey: Survey 

LADOTD_Right-of-Way_Map: Right of Way map drawings 

http://www.dotd.louisiana.gov/highways/project_devel/design/electronic_standards_disclaimer.asp
mailto:hollisward@dotd.la.gov
http://www.altivasoft.com/ladotd/


LaDOTD_CAD_Standards Folder Information (Highlights) 
Seed Folder 
‘Seed’ subfolders contain drawing template files (“seed files”) used to create new files.  Folders are 
generally named according to the Workspace Project that they serve (e.g., Bridge-Facilities).  Other 
subfolders include ‘_cell’ and ‘title sheet’.  Seed files are named logically according to their function.  
Some important attributes of seed files include border reference files, “dgnlibs”, color tables, active 
settings and CADconform feature table brands (standards used to create/check graphics).  When 
creating a new file, use the default seed file or select another seed file when appropriate. 

Border Folder 
‘Border’ subfolders contain borders that are referenced to seed files, and are generally named 
according to the Workspace Project that they serve (e.g., Road-Site).  The pre-attached border is the 
full-size border normally used with the seed file.  Replace this border when letter-size borders are used. 

Border reference files are pre-attached to seed files using the “Relative” method.  When using the 
Relative method, seed files will display the referenced borders.  When new drawing files are created in 
a project design folder using the seed file, the border will not initially display.  The border file 
pathname will appear red in the MicroStation Reference dialog box.  The border file must be copied to 
the project drawing folder so that it will display when the drawing file is reopened.  The project version 
of the border will display in drawing files as long as it remains in the project drawing folder, wherever 
that folder is moved or copied.  Exception: If new drawing files are created in ProjectWise, borders 
must be copied to ProjectWise and reattached.  Delete the old (red) border attachments.   
Tip: Use the Scan References utility to save time when resolving reference file attachments in multiple 
files, such as legacy drawings or consultant submittal drawings.  Red attachments will be fixed. 

Road Plan-Profile Borders: Specify these border reference attachments in Inroads Plan and Profile 
Generator as the ‘plan-profile_ sht4’ or ‘plan-profile_ sht5’ border as appropriate.  Inroads sets the 
reference scale to 240:1 (urban); and 600:1 rural).  The global 'active linestylescale' setting is preset in 
the plan-profile seed files to 20 and 50 respectively.  The 'active linestylescale’ is consistent with the 
Engineering scale of the drawing.  Note: Plan-Profile drawings cover a maximum of 300' per sheet at 
1”=20'; or 900' per sheet at 1"=50'.   See Special Functionality Highlights. 

Road Cross Section Borders: Borders are created to scale at 1”=5’ (urban) and 1”=10’ (rural) in the 
border file.  Cross section seed files reference these borders at 1:1 scale.  The global 'active 
linestylescale' setting is preset in the cross section seed files to 5 and 10 respectively.  The 'active 
linestylescale’ is consistent with the Engineering scale of the drawing.  
See Special Functionality Highlights. 

Cell Folder 
Cell files are logically named according to disciplines.  Recommended practice is to place cells using 
CADconform Draft (when available in Draft) to ensure that cells are appropriately used and scaled. 

Custom cell libraries can be used.  Such libraries must be conformed to appropriate DOTD standards 
using CADconform.  These cell libraries must contain only cells used in the project and must be 
submitted with the project.  Be sure to use the appropriate cell seed file, provided in the \seed\_cell 
folder, to create new cell files. 
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Dgnlib Folder 
“Dgnlibs” include levels, level filters, text styles and dimension styles used in Workspace Project seed 
files and borders.  When a level or style is actually used in a drawing file, then it is copied to the file. 
Note: DOTD does not use text styles at this time.   

Dgnlibs are referenced using two methods:   

• Project workspace configuration files (.pcf) define dgnlibs that are always referenced. 

• Manual Attachment: Open Level Manager and click Level>Library>Detach on the menu to see 
any dgnlibs that are manually pre-attached to the seed file (do not click “OK”).  Examples 
include mechanical, electrical and architectural in some ‘bridge-facilities’ seed files.  
Additional dgnlibs may be needed and may be attached if appropriate.  Example: Attach 
survey.dgnlib if survey linestyles are needed in a project file besides the survey graphics file. 

Dimension styles for the Bridge-Facilities project workspace are included in bridge-structural.dgnlib. 
Dimension styles for the Road-Site project workspace are included in road.dgnlib. 

Symb Folder 

Symbology resource files contain fonts and line styles that are referenced when viewing and printing 
drawings.  These files are logically named according to disciplines. 

Mdlapps Folder  
This folder contains MDL Applications that are available on the MicroStation Utilities menu. 

Steel.ma: Places standard structural steel shapes:  Steel Section Parameters must be adjusted so that 
steel shapes conform to standards using the BridgeFacilities CADconform feature table. 

Detailer.ma: Primarily used to customize and place steel welding and finishing symbols.  Adjust 
Symbology settings, place on Annotation level, and check for conformance using the BridgeFacilities 
CADconform feature table. 

Acadpan.ma: Sets view panning to behave like AutoCAD.  Allows user to click and hold mouse 
button to reposition drawing features in view.  This is loaded automatically when MicroStation starts. 

CellWiz.ma: Cell manipulation tool. 

Sscloud.ma: Create an annotation cloud.  Pick appropriate annotation line feature before executing. 

Celltool.ma: Places cells on or along elements 
Macros and UCMs Folders 

These folders include custom macros that are generally used in CADconform Command features or 
execute when MicroStation starts.  

Docs Folder 
This folder contains copies of help files, and example files.  Additional example files will be added as 
the DOTD workspace evolves.   
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Data Folder 
Highlights are as follows: 

• DOTD Color Tables: Contain colors that are used in seed files and borders. 

• Units.def: Defines unit definitions that are accessible in MicroStation; and includes 
information used to fix files that have incomplete unit information during file format 
conversion.  For instance, some DOTD legacy drawings have blank or unrecognized unit labels. 

• Dtools.rsc: Stores settings that are used to define annotation linear and text preferences for the 
MicroStation Drafting Tools palette.   

Config Folder 
LADOTD_CAD_Standards.cfg: This configuration file defines folder paths, MicroStation settings 
and CADconform settings that apply to all DOTD workspace projects. 

Project configuration file backups (\PCF folder): These files define folder paths and MicroStation 
settings specific to a workspace project.  See Installing and Managing Workspace Projects above. 

LaDOTD_seed.upf: A copy of this seed User Preference File (UPF) will automatically be used to 
create LADOTD_CAD_Standards.upf or to create a new one if the existing file has been removed.  
This file contains some settings needed for DOTD work, button assignments, file and folder history, 
and personal preferences, including screen layout of tool palettes and menus.  User Preference Files are 
usually located in the C:\Program Files\Bentley\Home\Prefs folder.   
Tips: Corrupt UPF files sometimes cause MicroStation to crash or prevent tool layouts from saving, so 
replacing the old file is a good place to start when such problems occur.  Save a copy of the old 
preference file in case it turns out that it was not the cause of the problem.  Delete the old UPF files 
before installing workspace updates to ensure that DOTD settings are up to date and to help prevent 
UPF corruptions. 

Inroads Folder 
This folder contains preference files (.xin) that define standards used in Inroads Survey and Bentley 
Inroads (road design).  Note: CADconform uses the RoadDesign feature table to check Inroads designs 
for conformance with DOTD standards.  CADconform features are normally set to match Inroads 
preference file settings.  Errors may occur when older designs are checked with new feature tables.   

Z_CADconform Folder 
• LADOTD_CAD_Standards.mdb: DOTD CADconform standards database 

• LADOTD_CAD_Standards.dsn: Defines Microsoft Access datasource name/path/settings 

• LADOTD_CAD Standards Help.pdf: Help specific to using DOTD CAD standards (this doc) 

• HTMLhelp.bat: Execute if CADconform Help (on CADconform menu) does not display 

• CADconform_2008.menu: Defines links and settings on the CADconform Menu 

• Cadconform.pwl: Stores CADconform user Profiles 

• Commands.mapping: Mapping file for converting MicroStation commands to AutoCAD
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Plotting Folder 

DOTD requires ProjectWise Interplot Organizer (Iplot) for plotting DOTD hard-copy and PDF 
drawings.  Iplot is required to ensure that drawing renditions are consistent regardless of what DOTD 
section/district or consultant prints the drawing.  Line widths, line patterns, plot labeling, drawing scale 
and other plotting attributes can be compromised if plotting is not configured consistently.  Attempts to 
emulate output with different plotting software often yield inconsistent or unsatisfactory results.  
Attempts to resolve problems are often time-consuming, slowing project delivery and collaboration.  
Additionally, resolving plotting problems increases support time and resultant costs.  DOTD does not 
have staffing levels to support unnecessary plotting problems, nor do most consultants.   

When plotting DOTD drawings, the following delivered resource files are designed to automate 
plotting and ensure consistency: 

Pen tables (\pen folder) define line widths, line pattern rendition, resymbolization, plot labeling via 
text substitution and other settings that affect the appearance of printed graphics.  Pen Table Naming: 

• Full.pen and half.pen are for ‘Dsize’ and 11x17 plotting respectively.  These are the default pen 
tables, which print the default submittal phase, CHECK PRINTS, outside the left border.   

• Other pen tables are used for labeling various submittals.  For instance, full_fpp.pen prints the 
plot label, FINAL PRELIMINARY PLANS.  See the end of the pen table file for the plot label 
text.  When it is necessary to eliminate the plot label, use full or half_nophase.pen. 

Color tables (\ctb folder) define colors for printing.  The default color table is bw.ctb, which is used 
to plot standard monochrome drawings.  For color printing, use bridge-facilities.ctb or road-site.ctb. 

Settings files (\set folder) define settings used to automate plotting.  Plot area, scale, layout offsets, 
display attributes, and attached pen table and color table are among the settings that are predefined. 
Often, all that the user must do to print a drawing is select the settings file and then print.  Settings file 
naming conventions are as follows: 

• BorderShape*.set: Plot limits are defined by a shape element in the file.  Normally used for 
printing entire drawings. 

• ViewFence*.set:  Plot limits are defined by fence or view boundary.  Normally used for 
printing specific details.  For view prints, first define the view and save settings.   

• TIFF*.set: For printing scanned drawings. 

Settings files are generic in nature.  Some minor adjustments may be necessary.  Edit settings files in 
Iplot Organizer (Edit>Settings Files>Edit).  Permissible adjustments to settings files are as follows: 

• Default printer names may optionally be added to a "Common" Section. 

• Adjustments to the XY Origin on the Iplot section "Layout" tab may be necessary, depending 
on the specific output device, to adjust margins to approximately 1/2” (top, bottom and right).   

Note: The printable areas on some printers may not be quite big enough to print at target scale.  For 
example, a target drawing scale of 2:1 may print at something like 2.0123:1. This is acceptable. 

Configuration files (\_cfg folder) include an Iplot Organizer shortcut, and a related batch file that sets 
default folder paths for settings files, pen tables and color tables.  Modify paths in these files as needed 
depending on the installation path of the LaDOTD_CAD_Standards Project Workspace folder.  Then 
deploy the shortcut to user computers.  Use Iplot Organizer for batch plotting and settings file editing.   
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CADconform 
CADconform Operation 
CADconform includes the following tools that are used to create drawings to DOTD standards 

Draft: Used by designers to draft to DOTD standards. 

Conform: Used like a spell checker to check standards for conformance and fix problems. 

Report Generator: The Report command is used by administrators to generate reports regarding 
features, errors and watermarks.  The Certify command is used to certify drawings, borders, and 
designs that are referenced to drawings.  All CAD deliverables must be certified, which is represented 
by a standard watermark.  For drawings, the watermark is affixed in the left border margin 

Manage Feature Tables: Used by DOTD to create drawing standards.  Used by designers to review 
feature functionality.  Designers are generally prohibited from modifying feature tables. 

User Manager: Used to manage user settings, security and passwords 

Feature tables 

The following feature tables are available for drafting, conforming and certifying DOTD drawings.  
Seed files are branded to automatically load the feature tables that are normally needed. 

RoadDesign: Road Plan-Profile, Cross Section and other Inroads designs; and add-on drafting. 

Landscape: Landscaping Cells: Used along with RoadSite feature table. 

RoadSite: Contains features that are common to Road, Landscape and site development disciplines.  
This feature table is used for road and site drawings types other than plan-profile and cross-sections.  
Annotation, Generic Site and Typical Section feature groups are included. 

BridgeFacilities: Contains features that are generally common to Bridge-Structural, Architectural, 
Electrical, Mechanical and Traffic drawings. 

Architectural: Architectural Drawings: Used along with BridgeFacilities feature table. 

Electrical: Electrical Drawings: Used along with BridgeFacilities feature table. 

Mechanical: Mechanical Drawings: Usually used along with BridgeFacilities feature table. 

Traffic: Traffic Signs, Signals and Markings: Used along with BridgeFacilities feature table. 

TitleSheet: Title Sheet Drawings 

Survey: Survey graphics that are referenced to design drawing files.   
Note: May be used to place survey line styles in drawing files if needed. 

RightofWayMap: Right-of-way map drawings 
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Important Feature Table Information 

Using Tools Effectively: Each tool on the CADconform Toolbox (e.g., Draft and Conform) includes 
valuable commands and settings.  Please take time to use CADconform help files to become familiar 
with what these tools can do for you. 

Feature Default Commands: DOTD CADconform features are normally designed to use a basic 
default command (e.g., place smartline).  It is normally permissible to change the command after 
selecting the feature (e.g., place block).  It is also permissible to change some settings that are 
associated with feature placement, if the settings are not in the feature definition. 

Feature Settings: Use Feature Table Manager to become familiar with specific settings that may affect 
drafting or conforming features (e.g., scale settings).  These are normally settings that are checked on 
the dialog tabs.  Additional settings, if they exist, may be viewed on the User Key-ins tab. 

“Variable” Features: DOTD allow variations from standard features in special cases.  For instance, a 
“Concrete Object Line” is placed at weight 2 by default.  In some cases a concrete object line may need 
to be displayed lighter (subdued) or heavier (bold).  CADconform features allow such variations in a 
single feature by using pick lists (Ranges) of variable element attributes.  In some cases pick lists of 
element weight, style and color are allowed in varying combinations. 

Special Case Features: Before variable feature functionality was available in CADconform, variations 
from standard features were addressed by creating a separate feature for each unique variation required.  
Such features were added as needed and placed in “Special Case” folders. For example, a Special Case 
subfolder exists under the Concrete folder in the BridgeFacilities feature table.   

Note: Special Case feature groups were phased out with the implementation of “Variable” pick lists.  
They were later reinstated, in addition to “Variable” pick lists, because CADconform does not support 
pick lists in AutoCAD. Only the default symbology attributes of such features are supported in 
AutoCAD.  Most MicroStation users find pick lists easier to use, and these features usually include 
more available combinations of attributes. 

Hidden Features: Features that are not used for drafting plans are hidden in the Draft menu.  Such 
features include features used to conform cells, and plans created with Inroads.  These features can 
optionally be displayed in the Conform checker pick list (magenta color), when used to conform cell 
libraries and Inroads designs, dropped cells, etc. 

Using the Draft Menu Effectively: The CADconform menu is relatively large for some CADconform 
feature tables.  For this reason, feature tables are designed to take advantage of the ‘Tear-off’ function. 
This function, available at the bottom of each feature group opened in the Draft Short Menu, can be 
used to isolate the specific feature group needed for the task at hand. 

ByLevel Functionality: Users sometimes may want to use ByLevel functionality instead of 
CADconform Draft. CADconform feature tables support ByLevel functionality, but using ByLevel 
settings in lieu of the CADconform feature table is generally not recommended (with a few exceptions) 
for DOTD drafting for the following reasons:  

• DOTD uses ByLevel Color extensively, ByLevel Weight sometimes and Bylevel Style rarely 

• It is not practical so use a different level for each combination of color, weight and line style 

• Many element attribute values are allowed in various combinations for various situations 
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• CADconform features add new facets to CAD standards, including attribute settings and 
configuration settings that cannot be addressed with ByLevel functionality. 

• For the reasons above, using ByLevel functionality in lieu of the Draft menu can result in many 
errors that must be addressed before the drawing can be certified. 

• Mechanical, Electrical and Architectural CADconform features may be applied effectively 
using ByLevel functionality in certain circumstances.  Se next subtopic below.  

Mechanical, Electrical and Architectural CADconform Feature Tables: These feature tables 
include standards that may be efficiently applied using ByLevel color in lieu of the CADconform Draft 
menu.  The feature tables are identical, except for level names and feature names (e.g., Mech1-Mech 
20).  If users can remember defaults and permissible variations in symbology attributes for one feature 
group, then they know defaults and permissible symbology variations for all feature groups. 

Special Functionality Highlights 
Global Active Linestylescale Setting:  

The Engineering Scale of a drawing is the same as the border reference scale if the border is measured 
in feet (e.g., 34’x22’).  In cases where the border is measured in inches (e.g., plan-profile borders), the 
border reference scale will be 12 times the Engineering Scale of the master file.  To further complicate 
the matter, urban plan-profile drawings are created at an Engineering Scale of 20, while referenced 
survey graphics drawings are created with active linestylescale 50. 

The global “active linestylescale” setting resolves differences in border measurement (inches or feet) 
and resulting differences in scale settings between master file and reference files.  For instance, urban 
plan-profile drawings are created at Engineering Scale 1”=20’ and a resulting global active 
linestylescale setting of 20.  These drawings reference survey graphics drawings having an active 
linestylescale of 50 and a reference scale of 1.0.  Plan-profile borders are measured in inches, use an 
active linestylescale of 0.0833 (1/12) for grid lines and are referenced to urban plan-profile drawings at 
a scale of 240 (12x20).  To view the active linestylescale setting, if set, type “active linestylescale”. 

The “active linestylescale” setting can be used for all DOTD drawings except for traffic drawings that 
use the Pavement Marking (PM) line styles.  PM line styles represent actual pavement markings (not 
symbols) at real world scale.  Place PM line styles at element line style scale 1.0 and other line styles at 
element line style scales equal to the border reference file scale. 

Scaling Cells in Inroads Survey:  
Start Inroads Survey XM Edition and check the Cell Scale setting on the Tools menu.  It should be set 
to 1.0 by default.  This setting places cells at 1.0 scale, which is correct for a 50 ft/in scale rural Plan-
Profile drawing.  To generate cells for a 20 ft/in scale urban plan-profile drawing, set Cell Scale at 0.4. 

Placing Engineering License Seals 

Four generic versions of Engineering License seals are provided in seal.cel.  Two are for Road-Site 
(designated “RS”) and two are for Bridge-Facilities (designated “BF”).  Seals for Road-Site are 1/12 
the size of seals for Bridge-Facilities, because Road-Site borders are 22”x34” whereas Bridge-Facilities 
Borders are 22’x34’.  To generate a new seal, simply copy the appropriate generic seal model, update 
the cell name and edit the seal text to match the engineer’s actual seal.  Do not change text attributes or 
the seal will not conform to standards. 
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Use the RoadDesign, RoadSite or BridgeFacilities CADconform feature tables (as branded on the 
drawing) to place the appropriate seal so that the seal will automatically place at the correct scale.  A 
“Generic Seal” feature can be found on the CADconform Draft menu in the “Seal” feature subgroup 
located in the Annotation or Misc group.  The Generic Seal feature will default to one of the generic 
seal cells.  After executing the feature, simply browse the Place Active Cells tool settings and double-
click on the specific engineer’s seal before placement.  As an option, it is permissible to create new 
features for placing each engineer’s seal by copying the Generic Seal feature and updating the cell 
name.  In this case, the specific Seal feature groups will have to be saved to dictionary files so that they 
can be restored when DOTD delivers specific feature table database updates. 

Title Block Enter Data Fields:  
DOTD title blocks use MicroStation “enter data fields”, which are placeholders for text entry.  Simply 
execute the “Fill in Single Enter_Data Field” command on the Main Menu/Text Palette and select the 
field for text entry. 

Title Blocks are usually a combination of enter data field information in the border file and enter data 
field information in the master file.  Use border enter data fields for information that will be constant 
for all drawings using that border, typically project number, parish and Section/District/Firm Name.  
Use master file enter data fields for information that varies from drawing to drawing, such as revision 
information, sheet number, drawing title, etc.  Exceptions to this rule include the following: 

• Title Sheets: All title block information is included in the master file.  Borders and title block 
enter data fields are included in seed files, which are used as templates to create master files. 

• Road Cross-Section drawings: All title block information is included in the border file.  Fill in 
the title block information for the provided border.  Then copy the border in the file for the 
number of borders needed.  Then fill in the sheet numbers. 

Imbedded Spreadsheets  

Imbedded spreadsheets may be used to create summary tables in MicroStation subject to the following 
criteria. 

• Use spreadsheets furnished in DOTD workspace when provided. 

• Use the Bent_Quantities.xls spreadsheet in the “…\docs\example spreadsheets” folder as 
example setup for new spreadsheets.  Use fonts and font sizes per the ‘Estimated Quantities’ 
tables when setting up new spreadsheets.   

• Excel “Comments” are turned on by default in example DOTD spreadsheets.  These can be 
turned off in the Excel View menu.  File worksheet “Protection” is turned on by default to 
prevent accidental modification.  Copy example spreadsheet files and turn off Protection to 
input or modify worksheets. 

• Users are responsible for submitting accurate quantity computations.  Provided spreadsheets are 
not guaranteed to be accurate or up to the latest design specifications. 

• Spreadsheets must be imbedded, not linked.  Starting on the MicroStation Main Menu, select 
the table to be embedded and pick Edit>Paste Special>“Embedded Microsoft Excel 
Spreadsheet”.  On the MicroStation “Paste OLE” settings box, paste as “Embedded” using the 
“By Size” method.  Set “Scale” as 1.75 x Engineering Scale of the drawing. 
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Drafting Tools Palette 

• This tool box can be found on the MicroStation Main Menu.  Select Tools>Annotation 
>Drafting Tools.  Note: Not designed to work with the Drafting Tools Place Title Text. 

• Properties for this command, accessible via the yellow “P” icon, are stored in 
…\data\dtools.rsc.  This file is locked with check boxes turned off and scale factors set 
appropriately, so changes to these settings cannot be saved.  Do not change these settings 
during the drafting process.  Instead, use CADconform Draft “Drafting Tools” features to set 
appropriate annotation attributes.  Then pick the appropriate command on the Drafting Tools 
palette.  The default command is “Place Callout Leader”. 

Using Fonts and Linestyles 

Font 101 (LEROY) is the font normally used for the Road-Site and Road Design drafting.  
Font 103 (design) is the font normally used for the Bridge-Facilities drafting.   

Font 103 is essentially the same as font 101, except this font contains many more special characters.  
For a table of special characters and associated keystrokes, see font 103 special chatacters.pdf in the 
\docs folder.   

The “Body .128" (special characters)” feature can be used in drawings that are branded with the 
RoadSite Feature table for text strings requiring special characters. 

Note: Most legacy fonts are included, but only the latest versions of line styles are used.  Viewing line 
styles in legacy drawings will present a problem.  Some possible solutions are as follows: 

1. Select line styles and change the scale to 1 (type “change linestyle scale 1”).  Then set the 
global “active linestylescale” equal to the engineering scale.  (e.g., type “active linestylescale 
50”).  If the line style has been renamed (unusual), change the line style to a current name. 

2. View the drawing in the appropriate legacy workspace.  * This is not the correct choice when 
the drawing has been copied for use in a new project.  In such cases, perform step 1 above and 
then conform the entire drawing to the latest standards using the CADconform checker. 
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CADconform Setup Basics 
The Altiva CADconform download is located at www.altivasoft.com/ladotd/.  After loading and 
licensing the software, please note the following procedures: 

The installed CADconform software configuration file (.cfg), which sets defaults for how 
CADconform checks drawings, should not be altered.  The LaDOTD_CAD_Standards installation 
delivers custom CADconform settings with the DOTD Project Workspace settings. Always configure 
CADconform for various clients so that they do not conflict with other clients. 

Managing Users:  Two LaDOTD seed users are delivered, “dotd admin” and “dotd user”, and display 
in User Manager.  The passwords are “admin” and “user” respectively.  First, open these profiles and 
change the passwords so that the defaults can be preserved.  Then use the “New” command to create 
new profiles for your site.  A delivered profile must first be selected so that the default settings will be 
copied to the new profile.  Use different names and passwords for the site profiles.  Multiple user and 
admin profiles are not normally needed unless there is a reason to vary permissions.  The delivered 
user settings are preconfigured to be appropriate for LaDOTD projects and should not be changed 
without careful consideration.  Some examples of permissible changes are as follows: 1. Allow trusted 
users to brand drawings. 2. Allow Draft to load on startup. 3. Lock feature tables. 
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